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Symbols and Conventions

ReadMe documents use the following symbols and conventions:

Symbol or Convention Meaning or Action

n A note provides important related information, reminders, 
recommendations, and strong suggestions.

c A caution means that a specific action you take could cause harm to 
your computer or cause you to lose data.

w A warning describes an action that could cause you physical harm. 
Follow the guidelines in this document or on the unit itself when 
handling electrical equipment.



If You Need Help

 3

If You Need Help

If you are having trouble using your Avid product:

1. Retry the action, carefully following the instructions given for that task in this guide. It 
is especially important to check each step of your workflow.

2. Check this ReadMe file for the latest information that might have become available after 
the documentation was published. Also check online for the most up-to-date ReadMe 
because the online version is updated whenever new information becomes available. To 
view the online ReadMe, select ReadMe from the Help menu, or visit the Knowledge 
Base at http://www.avid.com/readme.

3. Check the documentation that came with your Avid application or your hardware for 
maintenance or hardware-related issues. In addition to the printed documentation 
supplied with your editing application, the documentation is supplied in PDF format 
when you install the application. Topics that you print from the Help have limited page 
layout and formatting features. If you want to print a higher quality version of Help 
information, Avid recommends that you print all or part of the PDF version of the 
appropriate Avid manual included in the Online Library for your editing application. To 
access the Online Library, select Help > Online Library from within your Avid editing 
application. 

4. Visit Avid Online Support at www.avid.com/onlineSupport/. Online support is available 
24 hours per day, 7 days per week. Search the Knowledge Base to find answers, to view 
error messages, to access troubleshooting tips, to download updates, and to read or join 
online message-board discussions.

> This symbol indicates menu commands (and subcommands) in the 
order you select them. For example, File > Import means to open the 
File menu and then select the Import command.

This symbol indicates a single-step procedure. Multiple arrows in a list 
indicate that you perform one of the actions listed.

Italic font Italic font is used to emphasize certain words and to indicate variables.

Courier Bold font Courier Bold font identifies text that you type.

Ctrl+key or mouse action
k+key or mouse action

Press and hold the first key while you press the last key or perform the 
mouse action. For example, k+Option+C or Ctrl+drag.

Symbol or Convention Meaning or Action

http://www.avid.com/onlinesupport
http://www.avid.com/onlinesupport
http://www.avid.com/onlinesupport
http://www.avid.com/readme
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Hardware and Software Requirements
To access the list of qualified and supported platforms:

1. Go to www.avid.com/products/

2. Choose your product.

3. Click System Requirements.

Fixed in Avid Symphony v3.5.1

The following have been fixed:

➤ (Macintosh only) Permission errors prohibiting multiple users to log into the Avid editing 
system. This has been fixed, however, you need to remove any pre-existing AMALogger 
files before you start the Avid editor.

To remove any pre-existing AMA Logger files:

1. Before you start the new Avid editor application (v3.5.1), go to Macintosh 
HD/Users/Shared/Avid product name/Avid FatalErrorReports. 

2. Delete all AMALoggerxx_xx_xx.log files. (The logger files display a created date, for 
example: AMALogger03_11_09.log.)

This removes the old logger file from the previous version of the Avid editor (v3.5). A 
new logger file gets created when you log into the Avid editing application (v3.5.1), this 
logger file does not have any permission errors prohibiting multiple users from logging 
in.

3. You should be able to start the Avid editor application as multiple users.

➤ Previously, you might have experienced extremely slow timeline response time when 
working with XDCAM HD and XDCAM Proxy media in an Avid Unity MediaNetwork or 
Avid Unity ISIS shared storage environment. This has been improved. You should delete the 
MCState file and delete your Project Setting to take advantage of this new fix.

➤ Previously, some DV50 QuickTime imports did not import audio. This has been fixed.

➤ Previously, dragging a Color Correction template from a bin to a bucket did not apply the 
settings to the bucket. This has been fixed.

http://www.avid.com/products
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Compatibility Chart

The following table lists the operating system, NVIDIA® driver, QuickTime®, Windows 
Media™, Avid Interplay®, shared storage, Sony® XDCAM™, Panasonic® P2, and Pro Tools 
LE® versions that were qualified with the Avid editing applications. Also listed are the 
third-party applications such as Boris Continuum Complete, Avid DVD by Sonic™, 
Sorenson Squeeze®, and SmartSound® that ship with the editing applications.

Item Versions Comments

Microsoft® 
Windows® OS 
Support 

Windows XP Professional with 
SP2 or SP3

Windows Vista® Business 64 
with SP1

Windows Vista Ultimate 64 with 
SP1

Windows Vista Business 32 is supported 
on Avid Media Composer® software only, 
and Avid Media Composer with 
Adrenaline, Mojo SDI, Nitris DX or Mojo 
DX.

 Windows Vista Business 32 is supported 
on the HP® xw4600 systems with Avid 
Media Composer with Mojo DX (no 
DNxHD capture.)

Windows Vista Business 32 is also 
supported on the HP 8510w, HP 8710w 
and Dell® 6300 laptops with Avid Media 
Composer software only.

Macintosh® OS 
Support 

Leopard® v10.5.5 and v10.5.6 The Leopard OS has been qualified with 
the  Nitris DX hardware. The Leopard OS 
was not qualified with the old Symphony 
Nitris hardware.

QuickTime Support v7.5.5 and v7.6 QuickTime v7.6 has been qualified with 
Leopard v10.5.6. It was not qualified with 
v10.5.5.

Windows Media 
Version Support

Windows Media Player 11 If you do not have Windows Media Player 
11, access the download at 
www.microsoft.com.

Windows Media export compatibility is 
subject to Microsoft Windows Media 
updates.

http://www.microsoft.com/en/us/default.aspx
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Avid Interplay 
Support

See the Avid Interplay ReadMe 
for supported versions.

Macintosh editing applications are not 
supported in an Avid Interplay 
environment. IMPORTANT: The Avid 
Interplay components that get installed 
on the editing application must be 
updated to the Avid Interplay version 
that is released with the editing 
application. These include the Media 
Indexer, Interplay Access, Interplay 
Framework, Interplay Transfer Client 
and ProEncode Client. The Avid 
Interplay Server components can 
remain on the previous releases listed as 
supported. For details, see the “Avid 
Editing Application Compatibility with 
Interplay Releases” topic in the Avid 
Interplay ReadMe.

NVIDIA Driver 
Support

169.47 
(This is the version of driver 
tested with our editing 
applications. DO NOT upgrade to 
any other version.)

See “Setting up the NVIDIA Card” on 
page 8.

Shared Storage 
Support

Avid Unity™ MediaNetwork and 
Avid Unity ISIS®.

See “Shared Storage Support” on page 10.

Pro Tools Pro Tools LE v7.3.1 and v7.4.x

Pro Tools LE v8.0cs1 and higher.

• For information on supported versions 
of Pro Tools in an Interplay 
environment, see the Avid Interplay 
ReadMe.

• Interoperability is supported with 
Pro Tools LE v7.3.1 and v7.4.x; 
Co-install is not supported with these 
versions.

Item Versions Comments
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Sony XDCAM 
driver

PDZ v2.23 and FAM v2.04 
(Windows XP and Vista 32)

v2.8.1 (XDCAM Transfer for 
Macintosh)

Avid supports the Windows XP and Vista 
32 device driver for XDCAM decks, the 
Vista 64 device driver is not available at 
this time.
Avid recommends you install the Pro Disc 
2.04 driver on the Windows XP system 
running SP3 when using the following 
Sony PDW devices: 
PDW 1500, PDW HD1500, PDW 700, 
PDW 350, PDW F75, PDW F70, PDW 
D1. The driver can be downloaded from 
Sony's website http://esupport.sony.com/.

Avid recommends you install the VFAM 
driver v2.1.0 when using the PDWU1 
device. The driver can be downloaded 
from Sony's website 
http://esupport.sony.com/.

Panasonic P2 driver (Windows XP and Vista) Driver 
version for P2 devices: v2.02 - 
v2.4

(Macintosh) Driver version for P2 
devices: v1.2 

There is currently no P2 writeback 
support for Macintosh clients.

Boris Continuum 
Complete

v5.0.4 Ships with:
Avid Media Composer
Avid NewsCutter® 
Avid Symphony™ Nitris®

Avid Symphony Nitris DX

Avid DVD by Sonic v6.1 Ships with:
Avid Media Composer
Avid NewsCutter
Avid Symphony Nitris
Avid Symphony Nitris DX

Sorenson Squeeze v5.0 Ships with:
Avid Media Composer
Avid NewsCutter
Avid Symphony Nitris
Avid Symphony Nitris DX
Sorenson Squeeze is not compatible with 
systems running Vista 64.

Item Versions Comments
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Setting up the NVIDIA Card

To set up the NVIDIA card, you must make sure you have the correct display driver version, 
install the display driver if necessary, and set the correct display settings.

Prior to setting up the NVIDIA card, check to make sure you have the correct display driver 
version. If you do not have the 169.47 NVIDIA driver, you can install it from the Utilities 
folder that installs with your Avid application.

To check the NVIDIA display driver version:

1. Right-click the Desktop and select Properties.

The Display Properties dialog box opens.

2. Click the Settings tab.

3. Click the Advanced button.

4. Click the applicable Quadro tab. You might have to click the first element in the tree in 
the tab on the left when you click the Quadro tab, or you have to click the System 
Information link on the bottom left corner.

The version number is listed in the Graphics card information section on the ForceWare 
version line.

To install the NVIDIA display driver:

1. Navigate to Program Files\Avid \ Utilities \nVidia and double-click 
169.47_forceware_winxp2k_english_whql.exe.

2. Follow the on-screen instructions to unzip the NVIDIA file to 
C:\NVIDIA\Win2KXP\169.47.

The NVIDIA Setup program opens.

3. Follow the on-screen instructions, and then restart your system.

SmartSound v4.5 Ships with:
Avid Media Composer
Avid NewsCutter 
Avid Symphony Nitris
Avid Symphony Nitris DX
SmartSound is not compatible with 
systems running Vista 64.

Item Versions Comments
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To set Dualview mode if you are working with two monitors:

1. Right-click the Desktop, and select Nvidia Control Panel. 

2. In the settings window in the left of the window, click Set up multiple displays.

3. In the “Choose View display mode to use” area, select “Configure independently from 
each other (Dualview).

4. Click Apply, and then click OK.

Disabling the NVIDIA Driver Helper Service 
(Windows XP)

The NVIDIA driver Helper Service is a background program that runs with the NVIDIA 
Driver installed. This service informs you when an update to the NVIDIA Driver is 
available. There have been instances where this service causes slow restarts and shutdown 
with the Avid DNA hardware attached. The service also can prevent the Adobe® Photoshop® 
Gamma loader from operating, which causes color correction settings not to work properly. 
If this occurs, you should disable the NVIDIA Driver Helper Service.

To disable the NVIDIA Driver Helper Service:

1. Right-click My Computer.

2. Click Manage.

3. Double-click Services and Applications.

4. Double-click Services.

5. Right-click NVIDIA Display Driver or NVIDIA Driver Helper Service.

6. Click Properties.

7. Select Startup Type > Disable.

8. Click OK.

Every time you update or reload the driver, this service is enabled again. 
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Shared Storage Support

The editing application has been tested in a shared storage environment with the following:

Before You Install the Editing Application

Use the following information to determine which editing applications can be installed on 
your system.

Existing Editor Upgrades

The following existing editing applications can be upgraded to the following: 

• Media Composer versions v2.7.x and higher can upgrade to Media Composer v3.x (on 
WinXP OS). 

• Symphony Nitris versions v1.7.x and higher can upgrade to Symphony Nitris v3.x (on 
WinXP OS). If you are an Avid DS Nitris and Avid Symphony Nitris Dual Boot 
customer, you cannot upgrade to Symphony v3.0.

• NewsCutter XP and NewsCutter Adrenaline versions v6.7.x and higher can upgrade to 
NewsCutter v7.x (on WinXP OS).

Editing 
Application 
Operating 
System

ISIS Client 
supported 
version 

ISIS Server 
supported 
version

MediaNetwork 
Client 
supported 
version

MediaNetwork 
Server supported 
version

Windows XP v1.4, v1.5, v1.6, 
v2.0.1

v1.4, v1.5, 
v1.6, v2.0.1

v4.1.6, v4.2.4, 
v5.0.1, and v5.1, 
v5.1.1

v4.1.6, v4.2.4, v5.0.1, 
and v5.1

Windows Vista 
Business 32 and 
Windows Vista 
Business 64 a

a.Windows Vista Business 32 is supported on some Avid editing applications. See “Compatibility Chart” on 
page 5.

v1.5, v1.6, v2.0.1 v1.4, v1.5, 
v1.6, v2.0.1

v5.1, v5.1.1 v4.1.6, v4.2.4, v5.0.1, 
and v5.1

Macintosh 
Leopard 10.5.5 
and 10.5.6. See 
“Compatibility 
Chart” on page 5

v1.5, v1.6, v2.0.1 v1.4, v1.5, 
v1.6, v2.0.1

v5.1, 5.1.2 v4.1.6, v4.2.4, v5.0.1, 
and v5.1
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If you are a new customer (never installed an Avid editor on your system) you can install the 
following on an approved WinXP system or an approved Vista system:

• Media Composer v3.0 and higher

• Symphony Nitris v3.0 and higher

• NewsCutter v7.0 and higher

The following upgrade process to the Vista version of the editing application is not 
supported:

For example, if a Media Composer v2.7.x customer uninstalled the editing application, 
upgraded the OS from WinXP to Vista, and then tried to install Media Composer 3.x, the 
installation would fail. The only allowable Vista editing application installation is on a clean 
Vista system.

The Macintosh version of the Media Composer v3.x release can only be installed on a clean 
Macintosh with OS X Leopard.
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Notes on Vista OS

Note the following topics if you are running the editing application on the Vista OS.

Disabling Desktop Compositing

If you are running an editing application on the Vista OS, when the Avid editor is launched 
you might see a dialog box asking you to disable desktop compositing. You can disable it 
without adversely affecting the Avid editing application.

You can choose to disable it and continue with your editing session. The dialog will appear 
once you relaunch the application unless you disable the option.

To disable the desktop compositing:

1. Access the Control Panel.

2. Double-click System.

3. Click Change Settings.

4. Click the Advanced tab.

5. Under the Performance area, click Settings.

6. Uncheck “Enable desktop composition.”

The dialog box requesting you to disable desktop compositing does not appear the next 
time you launch the editing application.

User Access Control Setting

Windows Vista includes User Access Control (UAC), which makes you aware of changes 
that will be made to your computer letting you decide to allow the changes or not. Avid 
recommends that you leave UAC ON. This feature is turned on by default in the Windows 
Vista operating system.

Standard User

You need to first install the editing application as an Administrator. If you are in a Shared 
Storage environment, mount your workspaces as an Administrator. You may then log off and 
log back in as a Standard user, if necessary.

Vista Windows Sidebar

If the Vista Windows Sidebar is enabled, you might see flickering on the Timeline monitor 
when you stop playback. You should disable Windows Sidebar:
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To disable the Vista Windows Sidebar:

1. Right click on the Sidebar or Sidebar icon, and choose Properties.

2. Deselect “Start Sidebar when Windows starts.” 

3. Right-click the icon, and choose Exit to close the sidebar.

New Folder Structure

Some editing application folders have moved to a new location that is now shared and 
visible to the user on installation. These folders are created at installation time and are given 
special permissions to work for all users.

The following folders are created on your Windows XP system in the following location:

C:/Documents and Settings/AllUsers/Shared Documents/<AvidProductName>

• Avid Attic

• Avid Users

• Avid Media_Files

• Avid Templates

• Settings

• Avid FatalErrorReports

• sharedjvm/server/apps/MediaIndexer/stat/log

• MarqueeTitles

• AVX Plug-Ins Data

The following folders are created on your Vista system in the following location:

C:/Users/Public/Public Documents/<AvidProductName>

• Avid Attic

• Avid Users

• Avid Media_Files

• Avid Templates

• Settings

• Avid FatalErrorReports

• sharedjvm/server/apps/MediaIndexer/stat/log

• MarqueeTitles

• AVX Plug-Ins Data
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Cleaning up Old Folders Before Installation

Do the following to clean up old folders before you install the new ones if you are 
performing an upgrade.

To clean up folders:

1. Before installing  Symphony 3.0,  you need to uninstall your old version and any version 
of FilmScribe, EDL Manager, MediaLog, and Avid Log Exchange. 

2. Remove the following Registry keys on your system if they still exist after the 
uninstallation process.

HKLM/Software/Avid Technology/<productname>

HKLM/Software/Avid Technology/AVX Plug-ins

3. From the following folders, remove any folders that do not have custom data in them 
that you want to keep. If you do have custom data, copy the data to the new locations 
after step 4.

C:/Documents and Settings/AllUsers/ApplicationData/Avid/<productname>

C:/Program Files/Avid/<ProductName>

(Vista) C:/ProgramData/Avid/<Productname>

4. Install the new Avid editing application.

Notes on Software Licensing

If You Upgrade Your Operating System

If you need to upgrade your operating system after you install your Avid editing application, 
first deactivate your software. After you upgrade your operating system and, if required, 
reinstall your application, you can reactivate your software. For information on activating 
and deactivating your software license, see the Installation Guide for Avid Editing 
Applications.

Laptop Network Settings

Your software license uses information from your system’s network configuration. Some 
laptops disable the Network Interface Card (NIC) when connecting to the Internet through a 
wireless network connection. If you run your Avid editing application on a laptop, be sure 
that your NIC and wireless configuration is always the same as when you originally 
activated your software. See the user assistance for your computer for information on 
changing network settings.
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Using the GetLicenseInfo Utility

Avid provides a utility program — GetLicenseInfo.exe — that retrieves information specific 
to your license. This is useful if you no longer have the original license information or if you 
need to provide this information to Avid Customer Support. The license information 
retrieved by the utility depends on your system, but it can include the following:

• Avid editing product name

• License type

• Status

• System ID

• Serial number (for security reasons, only part of the serial number is displayed)

• Avid machine ID

To retrieve license information:

1. Navigate to one of the following locations:

t (Windows) Program Files\Avid\Utilities\GetLicenseInfo

t (Macintosh) Applications/Utilities/Avid Utilities/GetLicenseInfo

2. Double-click GetLicenseInfo.exe

A terminal window opens and displays your license information.

3. Copy the appropriate license information, and then close the terminal window.

Installing the Software

If you are updating from a previous release, you should uninstall the existing editing 
application. You should also uninstall Digi Drivers using Add/Remove from the Control 
Panel. Reboot the system and then install the new editing application. If you do not remove 
the Digi Drivers, the Audiosuite plug-ins do not load and you might receive either the error 
message “This software requires installation of device driver TPkd and a reboot before 
running” or a “DAE Interface NOT Available” error message. If you see these errors on a 
clean installation on a brand new system, install Hot fix KB926255 from Windows Update 
to fix the problem.

(Macintosh Only) If you are upgrading from a previous version of the Macintosh editing 
application, remove the Stereo Mixer.dpm and Surround Mixer.dpm plug-ins from the 
following location: Macintosh HD/Library/Application Support/Digidesign/Plug-Ins. If you 
do not remove these files, you might experience problems with the AudioSuite Tool.
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For all Avid editing applications, you must first log in as the Administrator (not just a user 
with administrator privileges), install the application, and initially launch the application as 
the Administrator. If you are working in a shared storage environment, mount your 
workspaces. You may then subsequently run the Avid editing application as a regular User.

(Windows) To install the Avid editing application software:

1. Quit all active applications.

2. Insert the editing application DVD.

3.  Click to Install the Avid Editor Suite or Individual Product and follow the on screen 
instructions.

n If the FilesInUse dialog box appears, you can safely select Ignore and continue.

n Depending on Windows activity on your system, some Microsoft Windows Driver Warnings 
might be minimized into your task bar at installation time. If your installation is taking 
longer than 5-10 minutes, please check your task bar for an icon with the word SOFTWARE 
in it. Click the icon and you may safely select Continue Anyway to continue your 
installation.

4. When prompted, select “Yes, restart my computer.”

(Macintosh) To install the Avid Editing application software:

1. Quit all applications.

2. Insert the editing application DVD.

3. Click to Install the Avid Editor Suite or Individual Product and follow the on screen 
instructions.

4. When prompted, select “Yes, restart my computer.”

New in Avid Symphony v3.5

What’s New

The following outlines the new features for the Avid® Media Composer® version 3.5, 
NewsCutter® version 7.5 and Symphony™ Nitris® products version 3.5 products. Each 
feature does not apply to every product model. See the More Info column for links to further 
details on the feature.
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Feature Description More Info

Software Activation Avid is now incorporating a software 
licensing option for activating your software. 

If you are a new customer, the 
Installation Guide provided in 
the documentation box 
provides software activation 
details. If you are upgrading 
from a previous release and 
ordered an upgrade kit, the 
Installation Guide in the 
upgrade kit provides software 
activation details. If you are 
downloading your software 
from the Avid download page, 
see the Install_SWLicense.pdf 
on the download page for 
software activation details. 
Also see “Notes on Software 
Licensing” on page 14.

Keyframeable Color 
Correction.

You can now animate most color correction 
adjustments using advanced keyframes.

See “Keyframing Color 
Corrections” in the Help. 

Long-GOP Video Mixdown The editing application now supports video 
mixdown using Long-GOP HD formats.

For more information see 
“Long-GOP Media Creation” 
on page 20.

Relink Enhancements You can now relink clips to any available SD 
or HD media and select the format and 
resolution within the Relink dialog box.

See “Relinking Media Files” in 
the Help.

Native Thin Raster Support On some system configurations you can 
directly select the raster size used for 
playback and editing.

See “Raster Sizes” in the Help.

BWF Audio File Support You can now import multi-channel, 
monophonic BWF files into an Avid editing 
system as a single master clip.

See “Working with BWF Files” 
in the Help.

Adjusting Audio Gain 
Before Import

When you import audio files, you can now set 
the gain on a clip without opening the Audio 
Mix tool. 

See “Adjusting Gain Before 
Importing Audio Files” in the 
Help.

Avid Media Access (AMA) 
Plug-In Architecture

Allows you to link clips (XDCAM, XDCAM 
EX, and P2) from a third-party volume into a 
bin without storing the media directly onto 
your system.

See “File Based Media” in the 
Help.
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XDCAM EX You can now import an XDCAM EX clip into 
an Avid editing application or use the AMA 
method to link to an XDCAM EX clip.

See “Sony XDCAM EX 
Media” in the Help.

XDCAM Added improved performance to the speed of 
XDCAM imports on both the Windows and 
Macintosh platforms.

See "Sony XDCAM Media" in 
the Help.

FluidStabilizer A new tracking engine specifically designed 
to track camera motion.

See “Stabilizing an Image” in 
the Help.

Modifying Sequences that 
Include Effects

This release adds several new or modified 
menu commands.

See “Promoting and Demoting 
Existing Effects in Sequences” 
in the Help.

Advanced Keyframe 
Changes

This release makes the following changes to 
advanced keyframe functionality:

• The Automatic Start and End Keyframes 
setting is no longer available in the Effect 
Editor settings

• The way that nested advanced keyframe 
effects behave in the Effect Editor has 
changed

All nested effects on a segment are now 
fully available in the Effect Editor. You 
can open and manipulate the available 
parameters and keyframe graphs for any 
nested effect at any time.

The old mechanism for changing the 
order of nested effects in the Effect Editor 
by dragging nesting priority icons is no 
longer available.

• If you have nested standard keyframe 
effects in a sequence, the Effect 
Editor shows only one effect a time. 
If you have a mix of standard 
keyframe and advanced keyframe 
effects in a nest, effects below the 
standard keyframe effect do not show 
in the Effect Editor unless you step 
into the nest.

See “Working with Advanced 
Keyframes” in the Help.

Feature Description More Info
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New Parameters for 
Generator Effects 

New options have been added to the SubCap 
and Timecode Burn-In effects.

See “Generator Effects” in the 
Help.

Stereoscopic This feature allows you to display and edit 
stereoscopic (3D) material.

See “Working with 
Stereoscopic Material” in the 
Help. 
The settings that control your 
monitor setup for stereoscopic 
editing are user settings rather 
than project settings. This 
might be inconvenient, for 
example, when you switch 
between a 3D and a non-3D 
project. Consider creating a 
user profile specifically for 
stereoscopic work that you can 
switch to whenever you load a 
stereoscopic project.

16-Channel Audio The Capture Tool now supports capture of up 
to 16 audio channels of HD-SDI input from 
supported HD devices.

See “HD-SDI 16-Channel 
Audio” on page 20.

AudioSuite Plug-Ins This release provides support for additional 
AudioSuite Plug-Ins.

See “Understanding Digidesign 
AudioSuite Plug-Ins” in the 
Help.

Digital Cut with HD 
Universal Mastering.

This release of Avid Symphony supports 
Digital Cut with HD Universal Mastering.

See “Performing a Digital Cut 
with HD Universal Mastering” 
in the Help.

CPU/GPU Acceleration With this v3.5 and v7.5 release, additional 
effects take advantage of the CPU/GPU 
acceleration.

See “CPU/GPU Acceleration” 
on page 20.

Change to 3GB Utility 
Procedure.

You should set the amount of memory you 
want to allocate for the application space on a 
Mojo DX and Nitris DX to 2700 instead of 
2500 as stated in previous releases. You will 
receive a reminder message when you launch 
the editor if attached to a Mojo DX or Nitris 
DX.

See “Extending Your Usable 
Address Space and Adding 
RAM for Improved 
Performance (Windows)” on 
page 53

Feature Description More Info
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Long-GOP Media Creation

Avid editing applications now allow full media creation and playback support for all of the 
specified Long-GOP formats and modes (XDCAM HD and XDCAM EX). This includes 
support for video mixdown using Long-GOP HD formats.

For more information on using Long-GOP formats in your projects, see “Long GOP 
Workflows” in Avid Interplay Best Practices v1.6.

HD-SDI 16-Channel Audio 

The Capture Tool now supports capture of up to 16 audio channels of HD-SDI input from 
supported HD devices. You can also enable up to 16 audio channels in the Digital Cut tool 
for insert edits when you use HD-SDI output.

n Not all decks support 16-channel audio. See the product documentation for your deck for 
more information.

The HD-SDI 16-channel output is available for Avid editing systems using the following 
Avid input/output devices;

• Avid Nitris DX

• Avid Mojo DX

CPU/GPU Acceleration

With the v3.0 and v7.0 releases, CPU/GPU acceleration of visual effects was introduced. 
The system automatically uses the available CPU and GPU resources in the host workstation 
to accelerate effects performance. With the v3.5 and v7.5 release, additional effects take 
advantage of this CPU/GPU acceleration. New GPU effects include 3D-Warp Perspective, 
SpinZ, Luma Key, and Peel.

Exporting improvements Avid supports embedded timecode when you 
export to XDCAM.

Avid supports embedded timecode when you 
export a QuickTime movie. 

Avid supports exporting 8 tracks of audio to 
MPEG IMX and XDCAM HD 50 Mbits.

Feature Description More Info
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And in the Render Settings options, the “Effects Quality Render Using” option has been 
changed to “Image Interpolation”. Note, the standard mode was the only quality mode 
supported in the previous release, except for Symphony Nitris.

Fixed in Avid Symphony v3.5

The following have been fixed.

➤ You might have received a "DIG_TOO_SHORT" error when performing a batch capture in a 
720p 59.97 project in an Avid Unity ISIS environment. This has been fixed.

➤ Previously, you could not perform a digital cut of DVC PRO HD media to a Panasonic 
AJ-HD1400 deck. This has been fixed.

➤ You may have received an error if you renamed a folder in the Project window and then 
saved a bin that resided inside this folder. This has been fixed.

➤ (Macintosh) You might have received "Segmentation Fault" errors when using JKL on a 
MultiGroup clip. This has been fixed.

➤ Previously, when working with the SpectraMatte effect with DNxHD 220 media and the 
Video Quality option for playback was set to Full Quality-10 bit, the application was 
extremely slow. This has been fixed.

➤ If you moved from Avid Unity MediaNetwork to Avid Unity ISIS, you might have 
experienced a delay on playback of 9 way MultiCam. This has been fixed.

➤ If you had filler at the beginning of a sequence and changed the display in the Timecode 
burn-In effect, the editing application might hang. This has been fixed.

➤ If an AVX1 effect was sitting directly on a filler clip, both the effect and the filler would 
disappear during the promotion. This has been fixed.

Image Interpolation

.

Sets a global override for effects that resize or reposition. The following 
options are available: 

Advanced (Polyphase): Causes effects to use the highest quality. 

Standard (Bilinear): Causes effects to use the standard high quality. 

Draft (Nearest Neighbor): Causes effects to use highest performance 
option though not necessarily finishing quality.
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➤ Previously, exporting a QuickTime reference took longer to complete than in previous 
versions of the editing application. This has been fixed. 

➤ Previously, an Avid Symphony Nitris system in an Avid Interplay v1.2.3 environment might 
drop frames when playing uncompressed video. This has been fixed.

➤ MetaSync enhancement matte keys were not importing correctly. This has been fixed.

➤ VFX and DPX Timecode was not appearing in the Record Monitor Timecode display or the 
Timecode window. This has been fixed.

➤ (Symphony Nitris DX) You might have received a  "Get Free Heap" error when memory 
exceeded 17%. This has been fixed.

➤ Previously, the application might not check for offline media prior to starting a Digital Cut. 
This has been fixed. However, if your sequence contains a meta track, you might still get an 
offline media message.

Limitations and Known Issues

AMA (Avid Media Access)

➤  If you apply an AudioSuite Plug-in to an XDCAM EX clip linked through AMA, the 
system freezes when you attempt to render. 

Workaround:  Consoldiate the media before you render, or do not install AudioSuite 
Plug-ins if you plan to link to XDCAM EX media.

➤ When linking clips through AMA, the metadata information might be missing when you 
switch from Brief view to Text view in a new bin.

Workaround:  Link the clips through AMA when the bin is in Text, Script, or Frame view. 

➤  P2 AMA import: On some projects such as 1080i59, the editor may not be able to 
consolidate or transcode from spanned P2 cards. The system displays the following error 
message: ConsolidateFMobs() Too Many Files. Workaround: If you encounter this problem, 
use the non-AMA method for importing media from spanned P2 cards. 

➤  While working in AMA, the Bin Column Selection dialog box doesn't always display all the 
bin headings. 
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Workaround:  Close and reopen the bin where the AMA clips are stored. The bin headings 
should all appear in the Bin Column Selection dialog box.

➤ Keep the target audio sample rate the same as the native audio sample rate when you 
consolidate or transcode a clip using AMA. If you choose to convert the audio sample rate, 
the system does not calculate the needed space requirement and the consolidate fails. You 
can however choose to convert the audio sample bit depth or convert the audio format for a 
successful consolidate to occur.

➤ The Avid editing system might be slow to respond while mounting multiple workspaces, 
while in the application, in AMA (Avid Media Access). 

Workaround:  Mount the multiple workspaces prior to opening the Avid editing 
application, and then work in AMA. 

➤  (Macintosh only) Offline clips appear selected (highlighted yellow) even after you eject a 
write-protected XDCAM EX (SxS) card.

Workaround:  Do not write-protect the card and do not eject the card while the application 
is running.

➤ Playing back XDCAM DV 25 media from a disc might drop or skip audio frames, this could 
be due to the disc needing time to spin back up.

➤ The following folder names: “OMFI MediaFiles,” “Avid MediaFiles,” “Contents,” “Clip,” 
and “BPAV” are application or camera generated file names which contain data appropriate 
media files. To avoid assertion failure errors when mounting volumes, do not create 
additional folders with these file names on your system. 

➤ When you link clips through AMA, make sure the bin is in Text, Script or Frame view. The 
metadata bin headings will not save in Brief view.

Audio

➤ If your system is an HP xw8400, you must customize the sound configuration in order for 
the editing application to correctly control the levels of the microphone or other connected 
audio device:

Workaround:  To customize the sound card configuration:

1. In the Project window, click the Settings tab.

2. Double-click Sound Card Configuration.
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3. Ensure that the Record/Input descriptions match the Playback/Output settings. For 
example, if you have a microphone plugged into the rear pink connector, then the 
Playback/Output option should be set to Rear Pink In. If you have a Line input audio 
device connected to the front black connector, the Playback/Output option should be set 
to Front Black In.

➤ Clip Pan: When you add an audio dissolve between two clips with Clip Pan onto a single 
audio track, the audio dissolve uses the Clip Pan setting on the outgoing source for the 
duration of the dissolve.

➤ Occasionally, you might receive a "ReadStreamAsyn" error when performing a Digital 
Audio Scrub. If you continue scrubbing, the audio will come back.

➤ Pan Automation (overrides Clip Pan when applied): When you add an audio dissolve 
between two clips with Automation Pan onto a single audio track, the audio dissolve 
interpolates the pan values between the pan keyframe value at the beginning of the dissolve 
and the pan keyframe value at the end of the dissolve. Any pan keyframe that exists in the 
middle of the dissolve is ignored.

Workaround:  Place the two clips on separate tracks using Clip Pan, fade one to silence, 
and fade the other up from silence.

➤ If you open a 720p50 HD project, open the Capture tool window, select HD-SDI video and 
Audio input. Capture an HD Clip from Satellite source using HD-SDI Embedded feature, 
saved it to Bin. Create an HD sequence using above saved HD Clip. Configure the Panasonic 
HD 150, set the deck to accept HD-SDI audio Embedded. Open Video output dialog: Turn 
on HD-SDI Audio Embedded ON. Attempt to output an HD sequence (Preview) to a HD 
deck using HD-SDI audio Embedded feature completely fail. There is no audio output signal 
seen on Deck.

➤ The Panasonic HD150 deck will not decode the HD embedded audio stream from 
Adrenaline or Avid Nitris.

Workaround:  Connect AES audio from the Avid DNA hardware to the deck and disable 
the embedded audio.

Audio Punch-In Tool

➤ You could monitor input during preroll in previous versions. If you have a software-only 
system, you can still monitor input during preroll. If you have an Avid Mojo, input 
monitoring begins at the IN point, not during preroll.
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Avid Unity

➤ (Macintosh) Avid editing clients cannot capture 8-bit 1:1 HD media to a mirrored Avid 
Unity MediaNetwork workspace; 10-bit HD media works fine.

Workaround:  To capture 8-bit 1:1 HD media to an Avid Unity MediaNetwork workspace, 
you must unmirror the workspace then capture the 8-bit HD media. You can then mirror that 
workspace after the 8-bit 1:1 HD media is captured. Synchronize the workspace with the 
Administration tool after the mirroring is re-applied.

➤ Avid Unity MediaNetwork and Power User login: If you log into your Windows system as a 
Power User and use the same login in the Connection Manager to log onto Avid Unity 
MediaNetwork, you won’t be able to play media.

Workaround:  In order to use an Avid editing application in Interplay you must log in as a 
Power User. However, do not use the same login when you use the Connection Manager to 
log onto Avid Unity MediaNetwork. Use a different login for the Connection Manager. This 
problem does not exist on Avid Unity ISIS.

➤ Workspace names in Asian characters might appear truncated at the end in any 
drive-selection list.

Workaround:  Use no more than 5 characters for workspace names.

➤ Changing Users on MediaNetwork Fibre attached clients: When you change users on a fibre 
attached client, do not use the Switch User function in the Windows Log Off dialog box. 
When you log back in as the original user you may get the following errors when you play 
media: “Exception: FILE_OTHER, filename… Exception: SYS_ERROR, status:1317, 
msg:The specified user does not exist.” 

Workaround:  To fix the problem once it occurs, reboot the system. To avoid the problem, 
before you switch users, log off completely and reboot the system.

Capture

➤  When performing captures over FireWire with the SonyZ7U or Canon XH-G1 camera, you 
might receive "Lack of progress" errors. 

➤ If you have problems with batch capture accuracy for footage captured over 1394 due to 
undetected small timecode breaks, select the “Enable detection of small timecode break” 
option located in the Capture Settings DV& HDV tab.
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➤  A 1:1 10 bit capture might fail with DIG_VDM_OVERRUN or video overrun errors. This 
might not occur if storage performance is optimized.

➤ (Macintosh) You might receive a “Mac Error - 37” error when accessing a target drive or 
workspace with 28 or more characters.

Workaround:  Make sure the target drive or workspace names are fewer than 28 characters.

➤ If you capture clips with an Avid editing system on two or more days and use the same 
project and the same tape name (for example, if you capture on two separate days from a 
cable feed named “Live”), relinking the clips might cause the old clips to relink to the new 
clips. Because the clips in this instance are captured on different days but use the same 
24-hour timecode and have the same tape name, the Avid system treats the captured material 
as coming from the same source. When you relink the clips, they relink incorrectly.

Workaround:  Avid recommends that you avoid using generic or nondescriptive tape names 
— for example, do not use the tape name “Live” for a live feed. Instead, use distinctive tape 
names for each capture. Also, you can use separate projects when capturing with your 
editing system. When you change projects, even if you use the same tape name for your 
captures the Avid system generates new source IDs. This prevents the relink problem.

➤ If you are working with DV tapes in the Sony HVR-M10U you might experience “failed to 
find preroll errors”.

Workaround:  Change the machine template to the “Generic_DVDevice-NTSC” or 
“Generic_DVDevice-PAL” template. This will force the software to use a different method 
for cueing to the preroll timecode.

➤ The editing application does not warn you if you try to send a Frame Chase editing clip to 
Media Services Transcode. Do not send ingesting clips to Media Services Transcode. Wait 
until the clip is completely ingested.

➤ You might see the following error message when loading a clip captured by Frame Chase 
capture in the editor: “Error encountered during relink process: New track length does not 
equal original track length.”

Workaround:  In the editing application, right click the clip and sequence and select Update 
from Interplay. In Assist, refresh the clip from the Interplay database by selecting the clip 
and pressing F5.

➤ When you are capturing and using the passthrough monitor, desktop passthrough might 
cover error messages that are in the same space as the passthrough monitor, preventing you 
from being able to read them.
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Workaround:  Move the affected window or message box away from the Record monitor, 
put another application in front of the Avid application, and then go back to Avid to force the 
UI to refresh. 

➤ When you capture from an HDV device through 1394 into an HDV interlaced project, you 
might see the video break up into squares. The captured media is intact and complete, 
however.

➤ When you capture media that includes invalid frames, you might see an error message that 
the capture has been aborted and the invalid frames discarded; it asks you if you want to 
keep the clip. This message is incorrect; the invalid frames have not been discarded.

Workaround:  Click No to discard the clip, and then recapture using new marks that 
exclude the bad sections on the tape. Do not keep the clip.

➤ When you deselect Enable Confidence View in the Video Display Settings dialog box and 
then open the Capture tool, the Client monitor does not display passthrough.

Workaround:  Do one of the following:

t Select Enable Confidence View.

t Click the Capture button in the Capture tool.

➤ In an HDV project, you can only capture audio at the 48k sample rate. Because the incoming 
audio is digital over FireWire® , the software is unable to up-sample 32k and 44.1k audio 
reliably during capture. If you try to capture audio at another sample rate, you do not receive 
the error message warning that the audio on the tape does not match the setting in the Audio 
Project Settings dialog. Currently, only the 48k sample rate is supported in the HDV project 
format.

➤ If you lose connection to your 1394 port or receive “OHCI Port Busy” errors, check the 
FireWire cable length. 

➤ When you capture HDV, the system might not find the preroll point if the Preroll setting is 
set to 3 or below. The default is set to 6. Do not set this option to 3 or below.

➤ (HDV) Passthrough does not work if Delay Audio is set to 7 frames or greater. (The Delay 
Audio option appears in the Capture tool.)

Workaround:  Set Delay Audio to 6 or fewer.



  

28

➤ Drop frame/Non-drop frame mismatch errors occurred often when capturing. A new Deck 
Preference setting has been added. Access the Deck Preferences Settings dialog box. A new 
“When the deck contains no tape Log as” option appears. Select the timecode format (Drop 
Frame or Non-drop Frame) for logging clips when no tape is in the deck. When a tape is in 
the deck, the system automatically uses the existing timecode format on the tape.

➤ (HDV) When switching from one project format to another while connected to an HDV 
device, you must turn the HDV device off and then turn it back on again. 

➤ (Windows) If after initially setting up a DV deck for the first time, or after a system recovery 
you cannot see the deck, manually register the DV buffers file by doing the following:

Workaround:  

Perform the following:

1. Go to Program Files\Common Files\Avid.

2. Right click Dvbuffers.ax.

3. Select Open.

4. Choose to select the program from a list and click OK.

5. Browse to windows/system32.

6. Select regsvr32.exe.

➤ The following error message, “Exception: ADM_DIO_ERROR_OCCURRED, 
DIOerr:Expected DV50 NTSC but received DV25NTSC” appears if you attempt to capture 
DV 25 from a DV 50 source or DV 50 from a DV 25 source. 

➤ When you batch capture long clips with a lot of metadata, the following error appears and no 
media is captured: “Exception: MXFDomain::SaveMetaDataToFile - Failed to save meta 
data to file.” This does not occur when you batch capture OMF.

➤ When you capture from a Panasonic AJ-SD93P or Panasonic AJ-SD93E, note the following: 
the Panasonic default for DIF SPEED is set to S400. The Adrenaline and Avid Mojo expect 
a DIF SPEED of S100. Capture fails, producing scrambled or blocky images.

Workaround:  From the Panasonic DVCPRO deck's menu, set the menu DIF SPEED to 
S100.

➤ When you capture DVCPRO HD from a Panasonic HD 1200A deck, keep the menu DIF 
SPEED set to S400.
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➤ Due to an issue with the RICOH FireWire controller on the Dell M65 and M90 laptops, 
when playing out to the host in 1394 mode, as well as a DV device via the “Output to DV 
Device” option, video and audio may drift out of sync.

Workaround:  Turn off “Output to DV Device.” Or, if you have to use the DV Device for 
monitoring, connect the speakers or headphones to the DV device/camera instead of the PC.

➤ Editing keyboard shortcuts such as Ctrl+X and Ctrl+C do not work in MetaSync Manager. 
Use the menu commands.

Digital Cut

➤ When performing a digital cut, you will receive the message “If you have a genlock signal 
connected to your BOB, please switch it to match the output rate. Use an appropriate black 
burst sync source. Then wait for the REF light on the BOB to turn green and press 
Continue.” If the light turns green, press Continue and the digital cut will be performed. If 
not, make sure an appropriate sync source is connected and wait for the REF light to turn 
green.

➤  (Avid Nitris DX/Avid Mojo DX) Currently the blue bar in the Timeline might not reach the 
end of the sequence at the end of a digital cut. All frames are actually cut to tape. 

➤  A “Media Offline in Composition” error might occur with a Digital Cut even when all 
media is online. Select Continue to perform the Digital Cut.

➤ (Macintosh) When performing a 720p/59.94 digital cut, the first frame of the sequence 
might be missing.

Workaround:  Add half a second of black before the sequence.

➤ The first 35 frames of a sequence might be missing when you perform a digital cut after 
selecting Crash Record and Ignore Time in the Digital Cut tool.

Workaround:  Add filler to the beginning of the sequence.

➤ When performing an HDV digital cut, the last few seconds are not cut to tape.

Workaround:  Generate a clip of black and add it to the end of the sequence.

➤ A digital cut of an HD project might drop the last frames of audio.

Workaround:  Add 10 frames of audio to the end of the sequence.



30

➤ When you perform a digital cut using the Pioneer® PRV-LX1 DVD recorder, select Ignore 
Time in the Digital Cut Tool window.

➤ A video underrun might occur at the start of a digital cut if the Digital Cut tool does not have 
focus when you click the Play Digital cut button. The Digital Cut window must be active 
before you click either the Start or Preview button. If an underrun occurs at the very start of 
the digital cut, you should be able to perform the digital cut without a problem.

➤ When you perform a digital cut to a Panasonic DVCPRO HD deck using HD-SDI with 
720p/59.94 material, several frames of black might be written to tape before the start of the 
outputted sequence. This might result in the end of the sequence being truncated on tape.

Workaround:  Place several seconds of black or color bars at the end of a sequence.

➤ The Digital Cut tool does not allow certain durations of black to be added to the tail of a 
sequence. Certain values (including 20 minutes, 30 minutes, 60 minutes, and so on) reset the 
clock to zero when applied. If the value you entered resets to zero when applied, adjust the 
value upward or downward until a satisfactory length is determined (at which point the clock 
does not reset itself and the desired duration is correctly applied).

Dynamic Relink

➤ Any MPEG2 352_30I MXF media created with an x.8.1 or x.8.3 editing application will not 
relink in Exact match in versions x.8.4 of the editing applications or the Media Composer 
3.0 or Symphony 3.0 or NewsCutter 7.0 versions of the editing application. The MPEG2 
352_30I MXF media created with an x.8.1 or x.8.3 was compressed at 15MB instead of 
2MB and therefore will not relink in Exact match. 

Workaround:  Change the Dynamic Relink settings to use the “Most compressed” option 
or change the “If no match is found” option to “Relink to Closest.”

➤ When working with HDV projects, HDV resolutions are not available for Dynamic Relink. 

Workaround:  Choose “Use Closest Media” instead of “Relink to Offline” when in HDV 
projects and “Specific Resolution” is selected as the Relink Method. If you do not choose 
“Use Closet Media”, captured clips appear as offline when Dynamic Relink is enabled.

➤ If you want to re-create title media at a target format other than the working format, you 
must change the project format to that designated for the target, otherwise only the working 
format resolutions are available.
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Effects

➤ You might experience dropped frames on the initial playback of a sequence containing a Pan 
and Scan effect. 

Workaround:  Set the Image Interpolation option in the Render Settings to Standard 
(Bilinear).

➤ You might receive a bus error when exporting a sequence in a 24p NTSC project that 
contains a scratch removal effect. Render the sequence first.

➤ Currently, you cannot preview Multi channel audio clips with AudioSuite Dynamic 3 
plug-in effects. The plug-ins work in the Timeline.

➤ If you try to conform an AFE created from the Avid Media Composer or Avid Symphony 
editing application to Avid DS, the Color Correction animation effects will not conform. The 
effects will be replaced with a wipe effect. You should demote the color corrections. 
Right-click the sequence that contains the Color Correction effects and select Demote 
Effects. This creates a a duplicate sequence that you can open in Avid DS.

➤ When you apply a SubCap or TimeCode Burn-In effect to a clip with the Effect Editor set to 
Thumbwheels, the first few characters in the text field are cropped from view. They do 
appear properly on the image.

➤ Applying Boris Continuum Complete deinterlace above other effects might corrupt the 
image.

➤ You might receive an “AudioSuite DAE” error when you render a master clip with a 
ReelTape AudioSuite Plug-in. The error does not occur if you render in the Timeline. 

➤ The Tracking window becomes deselected after switching from a nested effect to the 
top-most effect. You must close and then reopen the Tracking window to make it available.

➤ Currently, a Superimpose or Dissolve effect does not promote to 3D Warp.

Workaround:  First promote to Advanced Keyframe, then to 3D Warp.

➤  When the Color Correction window is open, Loop Play will include the sequence, not just 
the current clip, even if the Effect Editor is open.

➤ You might experience dropped frames when playing back an HD sequence containing a Safe 
Color limiter effect with the “422 Safe” option selected.
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➤ When working in 3D Advanced keyframes, occasionally, keyframe points might not display 
in the path.

Workaround:  Click the Enlarge or Reduce button located below the Effect Preview 
Monitor.

➤ In a 1080i59 project, effects that invert or resize the image might appear field-reversed 
during play in an SD timeline.

Workaround:  Transcode the media to SD.

➤ A clip with an unrendered TimeWarp effect might not import to ProTools. Render the effect 
before exporting.

➤ If you try to run AudioSuite and receive the following message, “Your computer is missing a 
Windows XP update required by ProTools. Please install all available critical updates before 
installing ProTools” you must perform a Windows Update, Custom Install to ensure the 
correct dll is installed.

➤ While in Effect mode, you might not be able to scrub through blue dot effects and have the 
monitor update. Move the Effect Editor so that it overlaps some part of the Composer 
monitor. The monitor should now update correctly when you scrub through blue dot effects.

➤ Currently, AAF cannot conform Pan and Scan correctly. Output an AFE.

➤ Safe Color limits might be exceeded in SD downconverted output from an HD project. In an 
HD project, if you use the Safe Color Limiter effect to ensure safe colors in a sequence and 
then output that sequence using SD downconvert, some transient pixel values might exceed 
your safe color ranges. This is a consequence of the resizing process performed in the Avid 
Nitris or Adrenaline hardware during an SD downconvert.

Workaround:  Change the project type to an SD type before you output or render the 
sequence.

➤ In 30i or 1080i60 projects, Timewarp effects that use the Film With 2:3 Pulldown Input 
format might not render correctly. Some frames might remain unrendered or it might not be 
possible to complete the render. This problem is known to occur in the specific 
circumstances described below, but might also occur in other circumstances.

Partial Render. The problem might occur if you perform a partial render of a Timewarp 
effect using the Film With 2:3 Pulldown Input format, then render the remaining part of the 
segment. Some frames might remain unrendered or the second part of the segment might not 
render.
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Division of rendered segment. The problem might occur if you render an entire Timewarp 
effect using the Film With 2:3 Pulldown Input format, and then divide the segment (for 
example, by performing an overwrite edit of new material into the middle of the segment). 
Some frames in the second part of the divided segment might become unrendered.

Trimming head frame of rendered segment. The problem might occur if you render an 
entire Timewarp effect using the Film With 2:3 Pulldown Input format, and then trim the 
head frame of the segment. Some frames in the segment might become unrendered.

➤ You might not be able to render a FluidBlur, FluidColorMap, or FluidMorph effect in an HD 
project if there is not enough memory available.

Workaround:  Try one of the following:

t In the Bins tab of the Project window, click the Clear button, and render the Fluid effect 
(see “Managing Bins and Memory” in the Help).

t Close all unused bins, relaunch, and render the Fluid effect.

t In the Format tab of the Project window, switch the project format to an SD format, 
render the Fluid effect, then switch back to HD.

➤ Very high speed Motion Effects with rates greater than 500% no longer play in real time; 
they now appear in the Timeline as a blue dot effect, and must be rendered. Since any motion 
effect with a rate greater than 100% plays back inefficiently, and the higher the rate the less 
efficiently it plays back, real time playback efficiency will improve by rendering such 
motion effects.

➤ (HDV) If a clip contains Timewarp effects, you should render the effects.

➤ You might experience effects render issues with stacked effects.

Workaround:  Render each individual track starting with the bottom track.

➤ When you are working with AVX effects, performing an Expert Render or a Render IN to 
OUT on a sequence that contains multiple third-party AVX effects might lead to excessive 
memory consumption that could cause the application to hang or to display errors.

Workaround:  Render the effects in smaller groups.

➤ AVX 1.0 effects might have invalid color levels.

➤ You might see problems with superblacks in 16-bit mode.
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➤ Performing an Add Edit on a promoted Advanced Keyframe Picture-in-Picture effect might 
cause a “DataPointOneError”.

Workaround:  Instead of first promoting to 3D, then Advanced Keyframe, promote in the 
reverse order.

➤ You might see a “FluidMotion Vector Edit Requires Full Resolution” error if you work in 
FluidMotion™ Vector Edit mode in anything other than full resolution (green mode in the 
Timeline). Render FluidMotion effects before you combine them with any other effects, 
especially any other time-based effects.

➤ (Progressive projects only) If a clip contains any of the following effects, you must render 
the effects before you apply Scratch Removal:

• Timewarp effects 

• Any effect that has been promoted to the Advanced Keyframe model

➤ Removing or undoing some timewarp effects might cause audio and video to lose sync.

➤ In the Transition Corner Display mode, two of the six frames display incorrect frames during 
trim operations initiated from the Timeline.

Workaround:  Trim using the Trim buttons.

➤ The Fluid film 2:3 timewarp effect might render incorrectly when you are rendering fluid 
motion type. The effect might flash a crop of left and right edges.

Workaround:  Set the left and right mask in the FluidMotion Editor to zero.

➤ (HD only) Any animated alpha matte over 35 seconds long might fail.

➤ When an Avid effect is applied in an SD 24p progressive project, it can create unwanted 
aliasing on the resulting clip.

Effects (Pan & Zoom)

You might encounter the following limitations when you use the Pan & Zoom effect:

➤ If you run out of memory when using Pan & Zoom, resize the images to a lower resolution 
using an application such as PhotoShop.

➤ (Macintosh) After the link to a Pan & Zoom effect is broken and you want to reestablish it, 
the application doesn’t prompt you for the source image name in the Open dialog box.
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Workaround:  Import still images into a bin and use them in the edit. With the imported 
image in the Timeline, apply the Pan & Zoom effect and load the respective file from the 
Open dialog box. This way you can use “Clip Text” and confirm that the correct images are 
being loaded.

➤ (Macintosh) After the link to a Pan & Zoom effect is broken and you want to reestablish it, 
the application doesn’t prompt you for the source image name in the Open dialog box.

➤ Pan & Zoom keyframe settings can revert to defaults if you select all keyframes when you 
link to a new picture.

➤ When you zoom in with Hi Qual and Ultra Qual filtering, you might experience a system 
error (Windows) or see green lines when you preview (Macintosh).

➤ To improve memory issues, the options in the Pan & Zoom Cache Fast menu are ignored and 
Video Resolution is used, although when you render the effect, the highest-quality resolution 
is always used. After you partially render a Pan & Zoom effect, however, you might see a 
slight pixel shift when you move between the rendered and unrendered portions.

Export

➤ QuickTime Movie export fails when using the Qualcomm PureVoice audio compressor. 

➤ (Mac Intel) You might have received "image buffer" errors when exporting to DNxHD in 
After Effects 7. This error does not occur with After Effects CS3 or CS4.

➤ (Macintosh) Exporting HDV files to the desktop results in a 0 k file on the desktop. The file 
will actually appear in your Macintosh User folder. If you export to a folder, note that the file 
will actually be created one folder level above.

➤ (Macintosh) When sending a QuickTime Reference to Sorenson Squeeze, Auto Load and 
Reveal Files do not work. Squeeze will launch, but the sequence does not load nor are the 
files revealed in the Finder window.

Workaround:  Manually import the files into Sorensen Squeeze.

➤ (Macintosh) If you try to Export to a read only drive you may get an exception. Ensure you 
are exporting to a writable drive.

➤ Export to HDV Device will fail on PC if your sequence contains native HDV media (HDV 
media captured from tape). Does not apply to Mac systems.

Workaround:  Transcode to another resolution before performing the export.
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➤ An error might occur when you export to HDV when the first frame of the sequence is a 
video mixdown clip.

Workaround:  Place filler or a frame of non-video mixdown media at the head of the 
sequence.

➤ Currently, our export settings allow a 720x486 size when you export Avid DV, which creates 
a field alignment issue. Make sure that you set the export settings correctly for 720 x 480 for 
DV exports. Currently, QuickTime must do a resize from 486 lines down to 480 and you 
receive an odd interpolation. (Even if you specify 720x486, the Quicktime file displays 
720x480.)

➤ In NTSC, QuickTime Same as Source and QuickTime Reference clips containing DV 
material can sometimes show visual distortions when burned to DVD from Avid DVD. This 
is because the DV portions are resized from the DV raster size 720x480 up to the standard 
NTSC raster size 720x486.

Workaround:  When exporting the QuickTime Same as Source or Quicktime Reference 
clips, choose “Use Avid DV.”

➤ (Macintosh) The editing application might crash after exporting to an Avid Unity ISIS 
Read-only workspace. Make sure you export to a Read/Write workspace. You can determine 
whether a workspace is Read/Write through the Client Manager application. Navigate to the 
Workspaces tab in Client Manager. The Read/Write workspaces are listed with an R/W 
under the name of the workspace. 

➤ If you have a mixed-resolution DV 25 sequence and try to export it as QuickTime for DVD 
using the Apple DV Codec, the .mov might contain artifacts.

Workaround:  You must use the Avid DV Codec for this kind of sequence.

➤ You might receive exception errors when exporting HDV 1080i/59.94 or 1080i 50 as 
Windows Media.

➤ When exporting to an HDV device, at least 4 to 5 seconds of media might be missing from 
the beginning of the sequence.

Workaround:  Add 10 seconds of color bar or black filler at the beginning and at the end of 
the sequence.

➤ When you export a QuickTime Reference movie, do not mix DV and non-DV media. If you 
mix DV and non-DV media, the resulting movie might contain line shifts.
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➤ When you export pan automation on an audio clip as AAF, it does not translate in Pro Tools. 
Pro Tools does not accept varying value pan controls during import.

➤ In the Export Settings dialog box, the default size is not the image size of the opened project.

➤ When you play an exported clip in the Windows Media Player, the sequence stalls in the 
desktop monitor. The audio plays, the blue bar progresses in the Timeline, and the video and 
audio output to the client monitor is OK. If the clip that is loaded in Windows Media Player 
is removed, then the Play operation plays properly in both the desktop and client monitors.

➤ Exporting Locators exports only a .txt file with frame count information, not timecode or 
Feet and Frames. Import also supports only frame count.

➤ (Encoding to Windows Media) A “Not enough memory is available to complete this 
operation or WM_BeginWriting_FAILED” error results from the application running out of 
available memory (RAM) while you perform the encode. Encoding to a Windows Media 
Video codec requires a lot of memory. The amount of memory required is directly related to 
the number of audio and video profile streams, width, height, bit rate, number of passes, 
VBR/CBR, and quality of the encoded video, as well as the resolution of the source media. 
If you encode HD media, you might need to reduce the bit rate, turn on 2-pass encoding, turn 
on VBR, lower the quality, or reduce the frame dimension.

➤ A “WM_FindInputFormat_FAILED” error might appear if the Windows Media exporter 
cannot find a suitable input format for a video or audio stream contained in the current 
Windows Media Export setting's stream profile. For example, using non-standard frame 
dimensions might result in this error. See the Microsoft Windows Media web site for more 
detail.

ICS (International Character Support)

➤ Workspace names that contain non-ASCII characters can cause poor performance when 
working in a bin. 

Workaround:  Use only ASCII characters in workspace names.

➤ If you capture a clip from a workspace with a French name through CaptureManager™, in 
the Avid editing application the bin heading Drive might be empty where it should list the 
French name of the workspace.

➤ If you change the font or font size of your input, and see characters rotated 90 degrees, make 
sure you select the correct font. Do not use any font that begins with the “@” symbol.
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➤ Do not create a project using the Euro currency character (ALT 0128). The project fails to be 
created and a “Can't Open Project” error message is displayed.

➤ Certain Asian characters might not appear in the correct order in some text boxes in your 
Avid editing application.

Import

➤ Occasionally, if you cancel an import of a clip, you might receive a 
“DISK_SHARING_VIOLATION” error.

➤ When you import an uncompressed QuickTime file, a PICT image, or a TIFF image, the first 
4 or 5 vertical columns of pixels might truncate when you display the file in the Source, 
Record, or client monitors.

➤ When you batch import a sequence with a graphic animation that was created in a 30i project 
and then modified in a 720p project, it might not import.

Workaround:  Import the graphic and manually edit it back into your sequence.

➤ Avid editing systems cannot import AVI files created on Avid DS Nitris systems. The import 
fails with an error message stating that the file format is not supported for import.

Installation

➤  (Macintosh) When launching the editing application, and the Audio is initializing, 
“CoreMIDIServer.framwork” might bounce in the dock. It may remain in the dock until you 
quit the editing application.

Workaround:  Delete DigiDioMidDriver.plugin from the Library/Audio/Drivers folder.

➤ After installing the editing application on the Vista OS, when you choose to reboot the 
system, the shutdown cycle is longer than usual. 

➤ On Windows platforms, occasionally the PACE installers do not properly update the iLok 
drivers.  PACE iLok drivers are used to copy-protect Digidesign plug-ins. If this happens the 
AudioSuite functionality in MediaComposer will be disabled.  To correct the situation the 
user should uninstall all instances of Interlok Drivers from the Windows Add Remove 
Control Panel and re-install the Digidesign Drivers from the CD or from Avid > Utilities.

➤ Once you install the editing application, and once the editing application tries to launch, 
while it is initializing, you might receive an “Unable to create index for editor slides” error 
message. 
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Workaround:  Right click the product.exe and choose “Run as administrator.” This causes 
the mdb and pmr files to update in the Avid_MediaFiles folder.The executable is located (by 
default) in C:\Program Files\Avid\Avid Product Name.

➤ (Vista) When the editing application is launched and a firmware update is required, you 
might be prompted to relaunch using 'Run As Administrator'. To run as administrator, right 
click the product.exe and select Run as administrator. The executable is located (by default) 
in C:\Program Files\Avid\Avid Product Name. Run as administrator is not available by 
right-clicking in the Avid editing application Shortcut icon.

Interplay Workgroup

➤ When you create a video or audio mixdown and add a locator, you might receive an 
“Exception: CM_NO_TC” error when you try and check the clip in to Avid Interplay. If you 
add the locator in Assist, then go back to the editing application and perform an Update from 
Interplay on the clip, the clip will check in successfully.

➤ (Vista) If you have a P2 drive mounted and you try to open the Interplay Service 
Configuration tool, you might receive an Exception error. Clicking through the error 
message might allow you to open the tool. If you unmount the P2 drive, the tool will open.

➤ When checking out a complex or long sequence from an Avid Interplay environment the 
following message might appear: “A request for data from the asset manager is taking a long 
time to complete. Would you like to continue waiting for the operation to complete or would 
you like to cancel?” If you choose to wait the sequence may load or you may get this 
message multiple times until the check out actually occurs.

➤ You might receive an access violation error while dragging multiple clips from the Interplay 
window into a bin. This occurs if you select an individual clip, drag it to the bin and then 
repeat the process quickly.

Workaround:  Select multiple clips and drag them to the bin.

➤ Selecting Check In All Open Bins from the Fast menu (hamburger menu) in the bin might 
not check in the open bins. 

Workaround:  To check in all open bins, select Check In All Open Bins from the File 
menu.

➤ After you perform a search for media in the Interplay Window, you cannot refresh the search 
results displayed in the Research panel by pressing F5. If you want to refresh the results, 
repeat the search.
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➤ Batch Import of files containing Alpha. This problem occurs if you want to batch import 
files in SD and HD formats and then use Dynamic Relink to switch between the different 
formats. The problem occurs with QuickTime movies, graphics, and sequences that contain 
alpha. You can batch import the files and relink to the different formats, but if you exit and 
then restart the Avid editing application you can no longer relink to the HD format. The 
system displays an “Exception: NO Compressed Data Format found” error message.

Workaround:  You cannot use Dynamic Relink with HD and SD clips that contain alpha. 
Import the HD files with alpha as individual clips. When you want to switch to HD format, 
edit the HD versions into your sequence.

➤ If you import a graphic from your local drive into a project in an Avid editing application, 
change the original name of the clip to a name of your choice, and check that clip into a 
folder in the Interplay Window, the new name does not appear in the Interplay Window even 
when you refresh the window. You see only the original name.

➤ When you import a clip onto local storage into a local bin and then delete the clip’s media, 
you continue to see the clip in the Avid editing application Source monitor instead of the 
message “Media Offline.” If you try to play the clip, an error message box opens.

Workaround:  Open another clip in the Source monitor, and then reopen the clip with the 
deleted media to correctly see the “Media Offline” message.

➤ When you incorporate clips and subclips that include locators added in Interplay Assist into 
a story in Instinct, the locators do not appear in the story. If you open the same story 
(sequence) in an Avid editing application, the locators do not appear there, either.

➤ In the Avid editing application, the Record Track monitor buttons might be deselected if the 
following happens:

1. On System 1, you create a sequence and check it into a folder in the Interplay Window.

2. On System2, you check out the sequence and load it into the Timeline.

3. On system1, you edit the sequence and check it into the Interplay folder again.

4. On system2, you refresh the Interplay window then check out the same sequence again.

Workaround:  Select the Record Track buttons again.

➤ In an Avid editing application, if you have a sequence that you have not checked into the 
Interplay Window and you try to use the Transfer > Send to Workgroup command, you 
might experience an error.
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Workaround:  Check the sequence into the Interplay Window before you attempt to 
transfer it.

➤ In workgroup environments prior to Avid Interplay, you could automatically consolidate 
from NewsCutter during Send to DMS. With the Avid Interplay release, the automated 
consolidate is not available. Choose to consolidate prior to sending to DMS.

➤ When working with MultiRez, high-quality audio cannot be distinguished from up-sampled 
proxy audio created with previous versions of the editor. For instance, an 8 kHz proxy audio 
up-sampled to 48 kHz on import in Interplay version 1.0 is considered as good as a real 48 
kHz high quality audio. In that case, if MultiRez is set to use 48 kHz audio, it picks up the 
most recent file of the two.

Force Disconnect Client Mode in an Interplay Environment

Your system administrator might need to temporarily remove your editing system from 
access to the network. This might occur if new software needs to be installed or if 
components need to be updated, for example. To force a disconnect, your administrator runs 
a script that forces disconnection from the network without physically removing your 
system. Your administrator can also reconnect your system at the appropriate time using 
another script.

It is possible to import from shared drives and export to them in Forced Disconnected Client 
mode. Avid recommends, however, that you do not import from or export to shared drives 
when your administrator has force-disconnected your editing system. Avid does not support 
any workflow that includes importing from or exporting to shared drives when the system is 
in Forced Disconnected Client mode.

In general, if you are in Forced Disconnected Client mode and if you import or export using 
shared drives, after the import or export those drives might appear to be available for other 
purposes such as importing, capturing, playing, or deleting media, but they are not available. 
Similarly, options for shared storage might appear to be available in various settings dialog 
boxes and shared drives and media might appear in various menus, tools, and applications; 
Avid does not support use of these settings, drives, or media.

To remove the shared drives from your drive lists, disconnect your network cables as 
described in “Voluntarily Disconnecting from the Interplay Environment” in the Help, or 
exit your editing application and restart it.

The following limitations describe specific instances of drives and options appearing in 
Forced Disconnected Client mode:

➤ In the Select Project dialog box, shared workspaces and projects are available and should not 
be.
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➤  Shared drives and media are available in the Media tool and in the MetaSync™ application 
and should not be.

➤ In the Interplay Server Settings dialog box, you can change the Interplay server name and 
you should not be able to

➤ In the Capture tool, you can select the Interplay Folders option as your capture destination 
and you should not be able to.

➤ In the MXF Media Files tab of the Capture Settings dialog box, you can select the “During 
capture, clip is updated in Interplay” option and you should not be able to.

➤  In the Temporary File Directory option of the General Settings dialog box, you can type the 
name and location of a shared drive and you should not be able to.

➤ Shared drives and media are visible in the Hardware tool and should not be. 

➤ Shared drives are visible in the Import dialog box and should not be.

➤ Options in the Media Services Settings dialog box are available and should not be. 

➤ Options in the Transfer Settings dialog box are available and should not be. 

➤  Selecting LANshare, PortServer settings, or ProEncode™ appears to be available but 
should not be. Do not select these options.

➤ Dynamic Relink can be enabled but that should not have been allowed. Do not enable it. 

➤  With several of the options in the File menu, you are allowed to select a shared workspace 
as a destination but you should not be able to. Do not select a shared workspace in this 
context.

➤  If you select Automatic Login at Project Selection in the Interplay User Settings dialog box, 
enter Disconnected Client mode, exit the mode and the editing application, reconnect, and 
then restart the editing application, you need to log into Interplay again and you shouldn’t 
have to.

➤  In Forced Disconnect mode, if you make a change to your User settings, the change might 
appear for all other users, as well.
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JVC 

➤ JVC recommends using the BR-HD50 deck to capture and batch-capture HDV media 
recorded with JVC cameras.

➤ The JVC GY-HD250U camera might drift out of sync while shooting in 720p/59.94. To 
avoid this issue, turn on the camera in 720p 23.976 and then switch the format to 720p 59.94 
causing a soft reboot.

➤ The Imported M2T files that were captured with a JVC GY-HD250U camera via the 
FireStore DR-HD100 will show up in the bin with the wrong durations. This occurs in 720p 
50 and 720p 60 projects.

➤ Currently, captured or imported M2T files might contain 1/2 frame offset. This occurs in 
720p 29 and 720p 25 projects.

Locators

➤ If you add a locator to a shotlist, and then open the sequence in an editing application, the 
locator appears, but if you perform a match frame on the locator, it might not appear in the 
master clip.

Workaround:  In the editing application, check the master clip in question out of Interplay 
and then update the bin or the clip. The locator appears.

➤ A new item has been added to the Fast menu in the Locators window. “Disable Locator 
Popup” disables the locator pop-up window. It is disabled only for the work session. When 
you restart the Avid application, the locator pop-up menu is enabled.

➤ (Macintosh) When you export locators from the Locator tool, the file might not be saved 
with the correct .txt extension and you might not be able to import it.

Workaround:  In the Choose Location for Exported Locators dialog box, add the file name 
extension .txt to the end of the file name before you click Save, or add the extension to the 
saved file before you import it.

Panasonic P2

➤ Reveal File does not function on master clips linked from P2 cards or virtual volumes.

➤ Panasonic P2 writeback is not supported on the Macintosh platform.
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➤ Export to P2 limitations:

• Use Marks and Use Enabled tracks are ignored on export.

• All Audio must be PCM 16b/48K.

• All audio tracks will be exported, although P2 devices either support 2 or 4 audio tracks. 
Therefore sequences should be built for delivery to the specified P2 playback device. 
Sequences with 6 audio tracks will have 6 audio tracks and the P2 device will only 
playback the first 2 or 4 tracks.

➤ Importing P2 limitations (Macintosh):

• Importing P2 Clips in a bin is only supported with one P2 Card mounted. With two or 
more P2 cards mounted, use the Media Tool, select the P2 Drives, click All Projects and 
click OK. All Master Clips from the P2 cards will appear in the Media Tool. Drag them 
to a bin.

• When importing from the Panasonic P2 Store device, Media Tool must be used as well 
on Macintosh.

➤ SD/HD Mixed sequences are not supported.

➤ 1:1 MXF media cannot be exported in both SD and HD projects. Transcode 1:1 MXF before 
exporting.

➤ (Macintosh) Hotswapping P2 cards with the editor launched is currently not supported.

➤ Occasionally the File > Import P2 > Media command does not consolidate media to the 
drives.

Workaround:  Close and re-open the bin and then execute the command again.

➤ When you view a P2 clip that spans across multiple P2 cards in the timeline, you might be 
surprised as to what you see and don't see due to the history of mounting P2 cards on your 
current system and the P2 cards that are currently mounted. Be aware that even though 
media is offline, or you are not able to view the P2 media in the Timeline, the media is not 
lost. The media appears when the card containing it is mounted.

➤ If you have P2 clips on a P2 card and you display the clips in the Media tool, you might be 
able to delete the audio and video .mxf files from the Media tool. 

➤ If you remove a card from a slot in the P2 reader and do not put another card in the reader, 
you must delete the P2 folder before inserting that same card in another slot.
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➤ A DVD drive cannot be a media drive. If a CONTENTS folder is located on the root level of 
the DVD, you might see a “No clips were found” message when performing an Import P2 
Clips to Bin. 

Workaround:  Create a folder that contains the CONTENTS folder on the DVD. This 
instructs the editor to mount a virtual drive.

➤ When the P2 CONTENTS folder is located at the root level on a drive where the Avid 
editing application looks for media files, you might encounter errors when importing P2 
clips. For example, if you are working on a laptop, the Avid editing application and local 
storage folders are on the same drive and are usually located at the root level. If you create 
virtual P2 volumes on the Desktop, you might encounter a “No clips were found” message 
when trying to import the P2 clips and media. 

Workaround:  If you locate the virtual P2 volume in a different location such as a subfolder 
on the Desktop, you should be able use virtual P2 volumes. 

➤ If you experience unusually long scan times, check to make sure both the local time and 
Greenwich Mean Time (GMT) are set correctly on your camera. If the GMT is not set 
correctly, you may need updated firmware for your camera. 

➤ Play performance for a multi-stream sequence suffers when you directly access media from 
the P2 media cards in the AJ-SPX800P camera.

➤ If you turn off the P2 card reader while a bin accessing P2 media is open, attempting to load 
any P2 clip results in a DISK_FILE_NOT_FOUND message in the Source monitor window. 
The message should read Media Offline.

➤ Dupe detection is not available for P2 source material.

➤ The following limitations currently apply when working with AVC-Intra resolutions:

• Real-time playback support on Avid Symphony Nitris is not guaranteed.

• QuickTime export is not supported.

➤  You cannot export a QuickTime movie using the Same as Source option with AVC-Intra 
material. ProEncode does not work with AVC-Intra material. This is related to the 
QuickTime problem because ProEncode creates a QuickTime Reference movie as part of its 
process.
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Play

➤ You might experience dropped frames when playing back XDCAM media with effects. 
When playing back media, a number of variables affect play performance; such as your CPU 
power, GPU power, sequence complexity and the raster settings.

➤ (MacBook Pro) After an initial launch of the editing application when attached to a Mojo, 
you might receive an “Assertion failed” error when playing back an HD sequence. 

Workaround:  Switch the project to NTSC or PAL.

➤ You might experience a slight delay at the start of play when Output to DV Device is enabled 
with progressive projects.

➤ It is possible on certain slower machines, when playing in MultiCamera mode, you might 
notice one or more cameras or the line-cut stutter a few seconds into the sequence. This 
happens most often when displaying the MultiCamera composite or line-cut to the client 
monitor on these older, slower systems. To help improve performance, Avid has provided a 
console command which allows you to pre-render more frames. This will slow down the 
start of play, but improve the overall playback performance.To increase the number of 
pre-render frames:

Perform the following:

1.  Open the Console window by selecting Tools > Console.

2.  In the Console command line, type the following command followed by the number of 
frames you want to prerender:

multicampreload 20

3. Press Enter (Windows) or Return (Macintosh). The value is saved. You do not need to 
reenter the command when you relaunch the editing application. To restore the default 
value, enter the command with no value.

➤ When you scrub a clip with “Fast Scrub” on, you might notice that when you stop scrubbing, 
the video may continue to play in the record monitor. This might be more noticeable in HD 
projects or when you are working on shared storage. Fast scrub actually has a number of 
frames in flight while you drag the blue bar. The in process frames continue to play once you 
stop scrubbing.

➤ (Mojo DX) Currently, if you open a 24p PAL, 25p PAL or 720p 50 project and load a clip 
into the timeline and then play the clip, you may see frames drop. 

Workaround:  Set your project to an HD project type and then back to your 24p or 25p 
project. You only have to do this once per session.



Limitations and Known Issues

 47

➤ When you play media and then you press stop, the source monitor stops, but the external 
client monitor steps back approximately 2 frames.

➤ (Macintosh) QuickTime reference movies are useful as long as you are working with Avid 
media files available on your local system or in an Avid Unity environment. However, if you 
expect to move the exported QuickTime file to a system that doesn't have access to the 
media, then you should use the standard QuickTime export so the media files and 
QuickTime wrapper can be moved as one file.

➤ With Full Screen Playback enabled on a single monitor, the video might stutter and you 
might notice tearing toward the top of the image during playback. Tearing might also appear 
if you use variable-speed play.

➤ When the Avid editing application stops streaming play, a number of additional frames are 
sent to the DNA device in order to keep the client monitor synchronous with the desktop 
display. The DNA device must play out that number of frames after the desktop has stopped 
playing. To make sure you view the actual last frame, the application then snaps the client 
monitor back to the frame on the desktop. This might be more apparent when playing 
HD media.

➤ If you do not see video output to your device, make sure that the appropriate device is 
selected in the Special > Device menu. If FireWire is selected in the Device menu, make sure 
Output to Device is selected in the Video Display Settings.

➤ If you experience a flashing monitor when attempting to play using the Japanese version of 
Windows XP, and your monitor does not appear to be covered by anything, adjust the state 
of your Language bar by maximizing and minimizing it. This restores the ability to play.

➤ (Adrenaline) LTC output is now off by default. To turn it on, open General Settings and 
enable “Generate LTC On Playback”.

Projects

➤ The following project types do not support XDCAM or HDV raster types:

• 1080p 23.976

• 1080p 25

The only raster type available for these formats is Standard.
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➤ (Windows Only) Avid Attic folders can only be created by Administrators. An 
Administrator has to first launch the application, open a project, close the project and quit 
the application. Then when a non-Administrator user uses the application, their work is 
saved to the Avid Attic.

➤ You should note the following when transcoding media. If you have a project in one format, 
such as 1080i 50 and you add a supported progressive format to the clip such as 1080p 25, 
once you transcode the media, if you try to delete the clip, the clip contains both progressive 
and interlaced media. The delete dialog does not indicate that the clip you are trying to 
delete contains both progressive and interlaced media.

➤ For NewsCutter projects, you can only select base timecode (TC1) display formats in the 
Tracking Information menu. You can view other timecode formats in the Timeline window, 
but tracking information does not display above the Source/Record monitor except for the 
base timecode.

Settings

➤ If you take your user settings from your Adrenaline, Mojo or Software Only system forward 
to a system running with a Nitris DX, Fast scrub will be disabled. New user settings with a 
system running with a Nitris DX will have Fast Scrub enabled by default.

➤ Currently, when saving toolsets, the bin position is not saved.

➤ Do not carry User Profiles from a previous version to this version. Create new user settings. 
If you do use previous settings, the size of tools and windows might not be as expected, 
especially tools and windows that have been updated for this version.

Titles

➤ (Macintosh) You might see vertical gray lines when you horizontally scroll the pages of a 
crawling title in Title Tool.

➤ (Macintosh) The background image might not display when editing an existing title from the 
Timeline.

Workaround:  Either promote the title to Marquee, or modify the existing title from the bin.

➤  (Adrenaline) Currently, an image might appear distorted in the Title Tool if you are in Draft 
or Best Performance play back mode. 

Workaround:  View the image in the Title Tool in Full Quality or Full Quality 10-bit mode.
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➤ If you re-create a rolling or crawling title in your sequence, the Scroll Position parameter 
values for the first and last keyframes are not preserved. They are set to the default values 
(start and end).

Workaround:  Promote the title to advanced keyframe model before you re-create.

➤ (Macintosh only) If you select the classic Title tool eyedropper and then quit the Avid 
application, the application hangs.

Workaround:  Deselect the Title tool eyedropper before you exit the Avid application. 

➤ Avid suggests that you do not attempt to edit the nested tracks of a re-created rolling or 
crawling title. If you attempt to select or edit one of these types of nested tracks, an error 
occurs. This is also the case with a re-created static title on its alpha channel subtrack. 

➤ A sys_error occurs when you modify a title to an available drive with Render settings that 
are set to an unavailable drive (a drive that you do not have write access to). A .bak file of the 
title also appears in the bin.

Workaround:  Close the Title tool and change the Render settings to a drive that you do 
have write access to.

➤ Character spacing might be inaccurate in Title Tool titles using large font sizes. Some 
character pairs might appear too close together, or overlapping. In HD projects, the problem 
is only visible in the rendered title clip in the bin. In SD projects, the problem is visible 
immediately in the Title Tool. Also, once the problem has occurred in text using a large font 
size, it might persist when you create other text objects in the title at any font size.

Workaround:  The best general workaround is to promote the title to Marquee®. Text in 
Marquee titles does not have the same problem at large font sizes. Also, if you do not need 
your final text to use a large font size, avoid converting it to a large font size at any point in 
your workflow, or retype it as a new text object at a smaller size if increasing the font size 
causes the problem.

➤ Marquee title format does not need to change in normal workflows. In most normal 
workflows, the title format in Marquee automatically matches the project format in your 
Avid editing application and you do not need to change it. If you change the title format in 
Marquee so that it does not match the project format in your editing application, you might 
see artifacts around the edges of some title objects. One situation in which you might need to 
change the Marquee title format occurs when you are creating a title by opening an existing 
.mqp file. If the .mqp file’s format does not match the project format in your Avid editing 
application, you should change the title’s format to match the project format in your editing 
application. For more information on changing the title format, see “Changing Title 
Formats” in the Marquee Help.
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➤ When you render a rolling or crawling NTSC SD title with Same as Source selected in the 
Media Creation dialog box in an HD project, you might see problems with the title.

Workaround:  For highest quality titles, re-create your title media in the format of the 
project in which you are working; in this case, re-create your SD title media in an HD 
format.

➤ Unrendered back-to-back titles in a 1080i HDV sequence might not play in real time. The 
second title does not display.

Workaround:  Render the titles.

➤ Rolling and crawling titles in 24p and 25p projects might display a “Layout Mismatch” error 
when in Full Quality mode.

Workaround:  Select another quality mode. The error also goes away if you toggle to the 
HD project equivalent and load the title.

➤ When you reedit a Marquee title in the Timeline, you might see artifacts in the video 
background. This is cosmetic only and does not appear in the resulting title.

Workaround:  If you reedit the title in the bin rather than the Timeline, the artifacts do not 
appear.

➤ For projects whose formats are changed to HD, if there are Marquee crawls in sequences, 
these need to be modified to keep them as Avid DSK titles. Reedit these titles by using the 
effect editor to bring up Marquee. If when saving to a bin in Marquee you receive a message 
that the title is animated or that it cannot be saved directly to the Timeline, then perform the 
following workaround.

Workaround:  Select the Crawl text box. Press the “C” toolbar button within Marquee to 
cause the crawling text box to extend for the new larger width of the title. Now you should 
be able to save to the bin or the Timeline as before and the title will not be animated.

➤ Page breaks appear on rolling and crawling titles when an HD title is over SD media, or an 
SD title is over HD media.

Workaround:  Recreate the title at the same resolution as the underlying video.

➤ HD titles appear aliased when you are not in Effect mode. Some titles you create in HD 
projects might look aliased (blocky) when you view them at Full Quality in Source/Record 
mode. To improve the visible quality, render the title or view it in Effect mode.



Limitations and Known Issues

 51

➤ The application might appear frozen after you edit a Marquee title in the Timeline. If you 
edit a Marquee title that is already part of a sequence in the Timeline and then exit Marquee, 
you might not be able to perform any other operations. 

Workaround:  Press the Escape key. Use a different user setting to avoid the problem.

➤ Rolling titles created in SD and rendered in HD display 1 line at the top of the matte when 
they are rendered.

Workaround:  Recreate the title and matte before you render.

➤ If you change the size of text, it might yield different kerning results. If you highlight text 
and change the text properties, the kerning result might be different than if you had changed 
the text properties in the Parent text box. For consistent results, change the text properties in 
the Parent text box.

➤ When you edit large or unrendered SD crawling or rolling titles in an HD project, switch to 
SD, promote the title to Marquee, save the title in SD, then open the title in HD. 

This workaround is not possible for a 720p project, but you can open the 720p bin in a 30i 
project and modify the title there, as long as there is an SD version of the sequence.

➤ Titles created in 4x3 SD and then re-created in 16x9 (SD or HD) appear to shift to the left. 
You must manually reedit the title in 16x9 for correct positioning.

Workaround:  In 16x9 mode, load the original 4x3 title in the Title tool. Click the Selection 
tool, select Edit > Select All, and then click Object-Group. Click Alignment > Center in 
Frame Horiz. Save the title to the bin.

➤ You might receive an “Out of Range” error when you try to modify and then re-create rolling 
and crawling titles in the timeline in a 720p project.

Workaround:  Manually reedit the titles into the sequence.

XDCAM

➤ If you are working with the PDW U1 device and you have "Automatically Import Proxies 
when disk is inserted" selected in the XDCAM Import Settings window, you will not receive 
the automatic prompt to import the proxy clips when the disk is inserted. For this device, you 
must manually import the proxy clips. The high resolution batch import process has not 
changed.
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➤ (XDCAM writeback) If you export a 720p50 or 720p59 sequence with an odd number of 
frames, you will receive a message indicating the sequence needs an even number of frames 
to export successfully. Add or subtract a frame and perform the export again.

➤ You might experience dropped frames when playing back XDCAM media with effects. 
When playing back media, a number of variables affect play performance; such as your CPU 
power, GPU power, sequence complexity and the raster settings. Depending on the 
complexity of your sequence, you might need to render some effects if you want to preview 
them in real time and at full quality, or before you can output a finished sequence. 

➤ When you batch import XDCAM clips from a virtual volume, the system re-imports the 
proxy media into your bin. If you batch import XDCAM clips directly from the XDCAM 
disk, this works as intended. If you do not have access to the XDCAM disk, Avid 
recommends that you import the hi-res XDCAM media when you import from a virtual 
volume and then edit your sequence.

➤ When you import XDCAM files, be aware that Avid does not support the batch import 
workflow when you are working in the following Sony XDCAM camera modes: Picture 
Cache Record Mode, Interval Record Mode, or VFR (Variable Frame Rate) Mode 
(UCC/OCC - Undercrank/Overcrank). An error message appears which informs you that the 
video is not supported. However, the High-Rez versions of these clips can be imported. 
Their timecode values, however, will be inaccurate. The Avid editor appends its own generic 
timecode to clips recorded in any of the previously mentioned modes.

➤ XDCAM proxy media will not export to a QuickTime reference movie. This is a limitation 
for all Long-GOP media types.

If you export as a regular QuickTime movie, MPEG 4, or as Windows Media 9, the export is 
successful. Or, you can transcode the proxy sequence to DV 25 or MPEG-IMX and then 
export as QuickTime reference.

Workaround:  Import the whole XDCAM HD clip and then transcode it.

➤ The Avid editing applications refer to XDCAM HD 25 Mbits media files as HDV 1080i 
50/60. These Dynamic Relink settings are only available in project types 1080i/59.94 HDV 
or 1080i/50 HDV.
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Extending Your Usable Address Space and Adding 
RAM for Improved Performance (Windows)

The Microsoft Windows XP and Vista 32-bit operating systems limit every program to 
2 gigabytes (GB) of address space. It reserves the remaining 2 gigabytes of address space for 
its own use. The operating system includes a boot-time mechanism that allows applications 
access to a larger virtual address space than was previously available. Avid provides a utility 
for setting the boot-time mechanism to extend the process address space.

For Microsoft Windows XP and Vista 64-bit operating systems, applications are allocated an 
address space well beyond the 2-gigabyte limit allocated by the 32-bit operating systems.  
No utility is needed to tell the 64-bit operating systems to allocate additional memory for the 
applications.

Setting your Avid editing system to access a larger virtual address space might improve 
working with HD projects without running out of memory. Even though you might gain 
more memory space, this can be quickly consumed with bins and complex HD effects. For 
best performance, if you choose to extend your address space beyond 2 gigabytes, you 
should install an additional 1 or 2 GB of RAM.

Using Install3GB.exe to Extend Your Usable Address Space 

It is not necessary to run this executable on Vista 64 systems. Perform this procedure on 
Vista 32 systems or Windows XP systems.

To extend the application address space:

1. Double click the Install3GB.exe file in the Utilities\3G folder where the Avid 
application is installed.

A window opens. You must have administrative privileges to run this utility.

n The hardware and software configuration you are running, Nitris DX, Nitris, Adrenaline, 
and so on, determines the amount of memory you should allocate for the application address 
space.

2. Type the amount of memory you want to allocate for the application space at the 
prompt. The recommended settings are:

- 2700 for Mojo and Adrenaline

- 2700 for Mojo DX and Nitris DX

- 2500 for Symphony Nitris Classic

- 2700 for Software Only systems
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Install3GB updates the current configuration you are running; it does not create another 
one. 

After pressing any key the window closes and you will need to reboot the computer. 

Restoring the Original Configuration

You can restore the system to the original configuration.

To restore the configuration:

1. Run the Install3GB.exe as described in “Using Install3GB.exe to Extend Your Usable 
Address Space” on page 53.

2. Type 0 (zero) for the memory setting.

This removes the “userva” setting in the boot configuration.

3. Reboot the system.

Documentation Changes

The following change has occurred since the print documentation was completed.

Exporting to XDCAM

In the Avid editor Help, the topic: “Exporting to XDCAM,” step 8 informs you that “If your 
exported sequence has more than two audio tracks, only two tracks are exported, even 
though the Sony XDCAM device is capable of handling 4 to 8 tracks. If your sequence has 
more than two tracks, they are mixed down during export.”

This should now read: “If you are using the Sony PDW HD1500 or the Sony PDW 1500 
XDCAM devices, export of up to 8 tracks of audio is supported for the MPEG IMX and 
XDCAM HD 50 Mbits formats. For other formats or devices that do not support 8 tracks, the 
system mixes down to audio tracks 1 and 2 during export.”

Capturing DV 25 Media

In the “Capturing DV 25 Media” topic in the help, the following paragraph was 
unintentionally omitted.

• If you are using an Avid Nitris DX or Mojo DX, or if you are not using an Avid 
input/output hardware device (software-only), you use a 1394 port on your computer 
(Host 1394). You specify that you are capturing via the 1394 port by selecting Host 
1394 from the Video menu in the Capture tool.
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Selecting a DV Device

In the “Selecting a DV Device” topic in the help, the following paragraph was 
unintentionally omitted.

• If your system has an Avid Nitris DX or Avid Mojo DX attached, the DNA/1394 button 
and the Special > Device menu do not appear in the user interface. DV capture through 
1394 and non-DV capture through your input/output hardware operate independently. 
You specify that you are capturing via 1394 by selecting Host 1394 from the Video 
menu in the Capture tool.

Selecting Asset Types

You should ignore the topic “Setting the Interplay Window Display” in the Help and use the 
following procedure. The option to select which media types display in the Interplay 
Window has been moved from the Bin menu to the Interplay Window. 

To select asset types and reference clips to display:

1. Right-click the Type column heading in the Research panel and select Set Type Filter.

n You need to right-click the column heading. If you right-click elsewhere in the column, the 
option does not appear in the context menu.

The Set Type Filter dialog box opens.

2. Select the asset types you want to display.



  

56

3. (Option) Select “Show reference clips” to display objects that are referenced by 
sequences.

4. Click OK.

5. (Option) Save the layout if you want to preserve your type filter settings.

Importing Proxy Media

Avid's new feature “Avid Media Access (AMA)” allows you to link directly to P2, XDCAM, 
or XDCAM EX media. However, if you want to import XDCAM proxy media, you can do 
the following. 

Turn off AMA:

1. In the Project window, click the Settings tab. 

2. Double-click AMA.

The AMA Settings dialog box appears.

3. Click the Volume Mounting tab.

4. Deselect “Enable AMA Volume Management.”

5. Quit and restart the Avid application.

6. Follow the steps in the Help topic: “Importing Proxy Media from an XDCAM Disc.” 

For more information about AMA and Importing and Exporting, see the section on “File 
Based Media” in the Help or in the Advanced Guide .pdf of your Avid editing system.
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Legal Notices
Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, 
Inc.

The software described in this document is furnished under a license agreement. You can obtain a copy of that license by 
visiting Avid's Web site at www.avid.com. The terms of that license are also available in the product in the same directory as 
the software. The software may not be reverse assembled and may be used or copied only in accordance with the terms of the 
license agreement. It is against the law to copy the software on any medium except as specifically allowed in the license 
agreement.

Avid products or portions thereof are protected by one or more of the following United States Patents: 4,746,994; 4,970,663; 
5,045,940; 5,267,351; 5,309,528; 5,355,450; 5,396,594; 5,440,348; 5,452,378; 5,467,288; 5,513,375; 5,528,310; 5,557,423; 
5,577,190; 5,583,496; 5,584,006; 5,627,765; 5,640,601; 5,644,364; 5,654,737; 5,715,018; 5,719,570; 5,724,605; 5,726,717; 
5,729,673; 5,745,637; 5,752,029; 5,754,851; 5,799,150; 5,812,216; 5,828,678; 5,842,014; 5,852,435; 5,999,406; 6,038,573; 
6,061,758; 6,141,007; 6,211,869; 6,532,043; 6,546,190; 6,596,031; 6,636,869; 6,747,705; 6,763,523; 6,766,357; 6,813,622; 
6,847,373; 7,081,900; D352,278; D372,478; D373,778; D392,267; D392,268; D392,269; D395,291; D396,853; D398,912. 
Other patents are pending.

No part of this document may be reproduced or transmitted in any form or by any means, electronic or mechanical, including 
photocopying and recording, for any purpose without the express written permission of Avid Technology, Inc.

Copyright © 2009 Avid Technology, Inc. and its licensors. All rights reserved.

Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or 
“commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf 
of a unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms 
of the License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks
888 I/O, Adrenaline, AirPlay, AirSPACE, AirSPACE HD, AirSpeed, ALEX, AniMatte, AudioSuite, AudioVision, AutoSync, Avid, 
Avid Advanced Response, Avid DNA, Avid DNxcel, Avid DNxHD, AVIDdrive, AVIDdrive Towers, Avid DS Assist Station, 
Avid ISIS, Avid Learning Excellerator, Avid Liquid, Avid Mojo, AvidNet, AvidNetwork, Avid Remote Response, AVIDstripe, 
Avid Unity, Avid Unity ISIS, Avid Xpress, AVoption, AVX, CamCutter, ChromaCurve, ChromaWheel, DAE, Dazzle, Deko, 
DekoCast, D-Fi, D-fx, DigiDelivery, Digidesign, Digidesign Audio Engine, Digidesign Intelligent Noise Reduction, DigiDrive, 
Digital Nonlinear Accelerator, DigiTranslator, DINR, DNxchange, do more, D-Verb, Equinox, ExpertRender, Face Robot, 
FACE ROBOT, FASTBREAK, Fast Track, FieldPak, Film Composer, FilmScribe, FluidMotion, FXDeko, HIIP, HyperSPACE, 
HyperSPACE HDCAM, IllusionFX, Image Independence, iNEWS, iNEWS ControlAir, Instinct, Interplay, Intraframe, iS9, iS18, 
iS23, iS36, IsoSync, LaunchPad, Lightning, Lo-Fi, Magic Mask, make manage move | media, Marquee, Matador, Maxim, 
MCXpress, Media Browse, Media Composer, MediaDock, MediaDock Shuttle, Media Fusion, Media Illusion, MediaLog, 
Media Reader, Media Recorder, MEDIArray, MediaShare, MediaStream, Meridien, MetaFuze, MetaSync, MicroTrack, 
MissionControl, NaturalMatch, Nearchive, NetReview, NewsCutter, Nitris, OMF, OMF Interchange, OMM, 
Open Media Framework, Open Media Management, PCTV, Pinnacle MediaSuite, Pinnacle Studio, Pinnacle Systems, 
ProEncode, Pro Tools, QuietDrive, Recti-Fi, RetroLoop, rS9, rS18, Sci-Fi, ScriptSync, SecureProductionEnvironment, 
Show Center, Softimage, Sound Designer II, SPACE, SPACEShift, SpectraGraph, SpectraMatte, SteadyGlide, Symphony, 
TARGA, Thunder, Thunder Station, TIMELINER, Trilligent, UnityRAID, Vari-Fi, Video RAID, Video Slave Driver, VideoSPACE, 
Xdeck, and X-Session are either registered trademarks or trademarks of Avid Technology, Inc. in the United States and/or 
other countries.

Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States 
and/or other countries. Apple and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other 
countries. Windows is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other 
countries. All other trademarks contained herein are the property of their respective owners. 

Avid Symphony ReadMe • Part Number 0130-07978-01P • 3/25/09

http://www.avid.com


  

58


	Title Page
	Symbols and Conventions
	If You Need Help
	Hardware and Software Requirements
	Fixed in v3.5.1
	Compatibility Chart
	Setting up the NVIDIA Card
	Disabling the NVIDIA Driver Helper Service (Windows XP)
	Shared Storage Support
	Before You Install the Editing Application
	Existing Editor Upgrades
	Notes on Vista OS
	Disabling Desktop Compositing
	User Access Control Setting
	Standard User
	Vista Windows Sidebar
	New Folder Structure
	Cleaning up Old Folders Before Installation

	Notes on Software Licensing
	If You Upgrade Your Operating System
	Laptop Network Settings
	Using the GetLicenseInfo Utility

	Installing the Software
	New in v3.5
	What’s New

	Long-GOP Media Creation
	HD-SDI 16-Channel Audio
	CPU/GPU Acceleration
	Fixed in v3.5
	Limitations and Known Issues
	AMA (Avid Media Access)
	Audio
	Audio Punch-In Tool
	Avid Unity
	Capture
	Digital Cut
	Dynamic Relink
	Effects
	Effects (Pan & Zoom)
	Export
	ICS (International Character Support)
	Import
	Installation
	Interplay Workgroup
	Force Disconnect Client Mode in an Interplay Environment
	JVC
	Locators
	Panasonic P2
	Play
	Projects
	Settings
	Titles
	XDCAM

	Extending Your Usable Address Space and Adding RAM for Improved Performance (Windows)
	Using Install3GB.exe to Extend Your Usable Address Space
	Restoring the Original Configuration

	Documentation Changes
	Exporting to XDCAM
	Capturing DV 25 Media
	Selecting a DV Device
	Selecting Asset Types

	Importing Proxy Media
	Legal Notices

